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Speed  

Speed in WiseMechanical has increased 1.5-2 times. All functions were optimised – from the file opening to 

the model update: speed of file loading, model regeneration, command execution for many objects.  

Support of .dwg 2010 

WiseMechanical supports format of AutoCAD 2010 drawing files. This allows interaction with all modern 

solutions supporting the *.dwg files and also Autodesk solutions – AutoCAD 2010/2011/2012. 

Using the clipbook to support AutoCAD, you can easily transport data from one environment to another.  

Program interface 

WiseMechanical was rebuilt and is close to the interface of classic CAD: the location of menu items and 

toolbars, commands in the command line.  

 

WiseMechanical is a system for drafting; here is why its interface was totally reorganised to optimise everyday 

workflow. The height of the command line, the number of toolbars on the screen was decreased; the right 

button menu was optimised.  

Selection of settings profile 

At the installation of the program you can select 

corresponding standards for drawing preparation: 

Furthermore, you can change a standard in the 

Mechanical>Settings dialogue. 
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New commands and aliases 

 

There are more than 500 commands and aliases which allow functions 

of the program to be performed using the command line. You can find 

most of the familiar commands: RE, REC, LINE etc. 

Toolbar «Object snap» 

The Object snap toolbar allows the switching on/off of different types of snaps.  

 

To open the toolbar, select View > Main Toolbars > Snap or from the context menu of the OSNAP button in the 

status bar. 
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 Layer manager 

The layer manager was seriously reworked. There is a category tree which allows the selection of all layers, 

used layers, layers of external reference, a group of layers, a filter of layers or a configuration of layers.  There 

is a list of the selected element’s layers in the right part of the manager.  

 

A drawing can be zoomed and paned when the layers manager is opened. 

 

Single layer view mode 

It is not always useful to switch off the visibility of the layers in the drawing (  icon). If there are a lot of 

hidden layers, it is difficult to display the content of each layer, because you have to set the previous state of 

visibility for all layers.  
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Single layer view mode addresses this problem. The visibility of all layers, except the one selected, is switched 

off in this mode, but is switched on when you close this mode.  

 

 

Grouping layers 

The Layer manager allows grouping of layers. Grouping is worth doing when a document contains a lot of 

layers or it is required to change the settings of the specified layers often. For example, it is possible to show 

quickly a group of layers on the drawing or switch on/off their printing. 

The tree of categories displays the groups, filters and configurations existing in the document. When you 

select an element in the tree of categories, the layers from the selected group, filter, configuration or external 

document link are shown in the right part of the manager. 
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A group is a set of layers, specified by a user. One layer can belong to different groups. A group is marked with 

 sign in the tree of categories. 

Creating a new group of layers: 

 

 

A filter forms the list of layers, satisfying the criterion of selection. Selection can be performed by one or 

several parameters of a layer. For example, selection of layers with line weight - 0.5 for printing. In the tree of 

categories a filter is marked with  sign. 
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Creating a new filter of layers: 

 

 

 

Recovery of layer’s parameters 

 

The configuration of layers is contained within a named 

backup copy of the layers’ parameters with the ability to 

edit and recover them.   The layers’ configurations are 

stored in a separate folder and marked with  sign in 

the tree of categories. 

Recovery of configuration means copying the parameters 

of the same name layers from the configuration into the 

document. To recover the configuration, select it from the 

context menu of the configuration in the tree of 

categories.  

A configuration can be exported in a .dwg or LAS-file and 

imported from them again.  

 

Mode of insertions editing 

There is a new ability to edit external references (DWG insertions and blocks) in the mode of insertions 

editing.  
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In the editing mode a working set, which can distinguish objects belonging to an external reference or 

description of the block from the objects from the drawing, is made from the objects inserted as an external 

reference. You can add new objects to a working set and exclude any already added. New objects, created 

during the editing insertions, are almost always automatically added to a working set.  

Tools > External reference > Edit reference.  

Command line – REFEDIT. 

The Select insertion dialogue contains information about the selected reference and nested objects which can 

be selected for editing. 

 

After selecting objects for editing, the refedit toolbar appears. Using the buttons of this toolbar you can add 

and exclude objects from a working set and save or cancel changes of insertions. 
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 Command line 

 

Entry of relative coordinates 

Relative coordinates are calculated from the last specified point. It is useful when the position of the point 

from the previous point is known. To set relative coordinates use the '@' symbol before a value. For example, 

@7, 8 marks a point placed in 7 units from the previous point in the positive direction along X axis and in 8 

units from the previous point in the positive direction along Y axis.  

 

Entry of polar coordinates 

Polar coordinates are very useful to draw lines in the direction of something. The position of the point is set by 

the distance from the previous point and the specified angle. The values of distance and angle are separated 

by the < symbol. For example, to enter a point, set in 9 units from the previous point and with 35 degrees 

angle, type 9<35. 

 

Calculation of mathematical expressions 

You can calculate mathematical expressions in the command line at any time. To calculate a mathematical 

expression, type the '?'. A full list of registered mathematical functions and constants can be displayed in the 

command line when entering the '?' symbol. Variables, specified by a user, can be added to mathematical 

expressions. Such variables are defined with the following syntax: ?<variable>=<value>. 
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Copy of the command line using F2 

When the F2 key is pressed, a copy window of the command line appears.  

 

You can close it at any time and open it again later. The next time it is launched, the window is at its previous 

size and position, but it is always over the main window, even if the cursor is moved in the drawing area or 

other windows. 

 

Auto hide mode in the command line 

Now the command line can be switched into auto hide mode. In this mode the command line is hidden in the 

tab. In the tab name you can always see the command line’s message and entered values. 
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The entry of commands and required values are performed without showing the command line. When the 

cursor is moved over the tab, the command line expands to its full size; it shrinks again when the cursor is 

moved away. 

To switch on auto hide mode, select Autohide mode from the context menu of the command line. 

The command line is hidden when working with a drawing, but you can see the current messages of the 

command line. A command or values entry can be performed without expanding the command line.  

To select a parameter of the current command, open the context menu in the drawing area: 
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 Programmatic access using ActiveX ® API 

Programmatic access to the application is achieved using AсtiveX® API. The Programmers Guide about the 

WiseMechanical object model is in the Help folder. 

 

Autofinishing commands and settings of the right button 

WiseMechanical has a classic CAD interface. There is a command line where you can enter commands or their 

parameters in the bottom part of the window; there are numerous toolbars on the sides of the working area 

and the mouse is used for selection.  In the 30 years since the development of this interface, a lot of users 

have got used to it. Autofinishing commands and the settings of the right button must be in a professional 

CAD solution. Let’s look how this is achieved in WiseMechanical. 

Autofinishing commands – this is a very easy to use mechanism. When you start typing a command in the 

command line, a new temporary window emerges over the command line with all the commands, containing 

typed symbols. For example, when you enter «li», LIMITS, LINE, LINETYPE and LINM commands are shown: 

 

 Adding a new symbol reduces the number of commands shown. 

By pressing the TAB button there is round robin of commands in the pop up window, and you just have to 

press ENTER to start a selected command.  

If you do not want to press ENTER you can set the right button parameters:  

 

If the right button works as ENTER, you just have to press the right button. ENTER is used to confirm entry of 

data and repetition of operations, so such a setting of the right button is very useful.  
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There is one exception: if any object is selected and you want to do something with it – copy, change its 

properties, replace or select similar objects, select these commands from the right-button menu. The “Repeat 

last command when nothing is selected” setting is important this case.  

Try to adjust WiseMechanical as shown in the picture and your productivity will increase! 

The improved object selection 

Work with a dense drawing is complicated. When the drawing is full of objects, selection of the objects 

becomes difficult.  

The object selection mechanism is improved in the new version of WiseMechanical. You can click the object 

group which is located close together or overlaid one on another and the Selection window appears. In this 

window you will see objects that are located under the cursor at the moment. You should specify which 

objects you want to select or, by one click, choose All, or cancel by clicking Nothing. 

 

If you select a group of objects by frame and use the Object type filter in the Inspector window, the Remove 

from selection and Leave in selection icons will be active.  
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Advanced grips 

The grips are often used to carry out object editing in the design system. If you select an object, you can see 

the blue markers (squares, circles, ellipses, etc.) in its node points. Use these grips to modify the object – to 

stretch it, move it, rotate it etc... 

There are different methods of editing using the grips– for example, it is possible in the leader note to add 

extension lines, change text alignment or change the arrow type: 

 

Advanced grips are very helpful in the designer’s work – it is the most intuitive, fast and convenient method to 

edit objects. 

In the new version of WiseMechanical you can use advanced grips for polygonal objects: polylines, hatches 

and limits of polygonal viewports, as well as with lines, arcs, and splines. 

Consider some of them in detail in the example of a polyline. 

When you select the polyline, you can see two types of node points: in the vertex of the polyline (type 1 – look 

like a “classic” grips) and in the middle of segment (type 2 – flattened and look like rectangles): 
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If you click the node point in the middle of any segment, the segment can be moved right after the cursor (fig. 

3-a). If the CTRL key is clicked once, you can add a new vertex (fig. 3-b). And if the CTRL key is clicked again, 

the line segment will be transformed to an arc (fig. 3-c). 

 

It is possible to apply the same action to polylines vertices. In that case, the vertex will be moved, removed 

and added (fig. 3-d, 3-e, 3-f). 

Try it and see how convenient it is! 

Multiline text 

Using the Multiline Text command (MTEXT) you can set the colour of the symbols in the Text format dialogue 

at the editing process. You can set the background for the selected text block in the Inspector window. These 

options are useful when working with complex drawings: 
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The Edit multiline text command was improved. There are undo/redo buttons, indent from edge and 

tabulations: 

 

 

 Undo/Redo buttons for multiline text.  

You can select separate fragments of text and edit their parameters.  

The command automatically zooms the text for easy editing. 
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To insert a special symbol, select 

the Insert symbol command from 

the context menu.  

 

 

Smart Trim and Break vectors at point  

In the process of objects editing, you can use one of two new commands – Smart Trim and Break vectors at 

point. If you need to break the line on two segments, use the Break vectors at point command. Just click the 

mouse at the required point on the line. 

Using the Smart Trim command, you need to select the object to trim. Then, by analysis of the drawing 

geometry, the nearest intersection points of the trimmed object to other objects are found. One click and the 

object is trimmed: 

 

Working with paper space and viewports 

The modern technologies of design allow preparation of the drawings in the paper space. It is more 

convenient because it is possible, by using the viewports, that the same model can be prepared on multiple 

layouts in different scales. Much attention has been paid to updating this functionality in the new version of 

WiseMechanical. 

First of all, the speed of operation when you switch from model space to paper space and back was increased. 

It is noticeable in drawings which contain a large number of viewports on the layouts. An additional control 

element was entered – the button between the layouts and named views: 
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Typically, switching between layouts or model space was carried out by tabs at the bottom of the screen. It is 

convenient when there are only a small number of layouts. If there are a lot of layouts, then the tabs “escape” 

under the scroll bar. To find a tab, it is necessary to click in the last visible tab and wait whilst the program 

handles this transition, and then click again, and again and again… When the drawing is complicated, it can 

take a long time.   

The additional button, located at the end of the tabs list, allows you to switch to whichever layout is required 

with just two clicks. The advantages of such a function are clear.   

The preparation of drawings, implemented through the viewports, required future functional development. 

For example, in the previous version, the viewports were not blocked from the changes, it was difficult to set 

the scale, reference to the objects of viewport was absent, etc.  

The new version took the most important comments of users into account. Working with viewports was much 

improved. Note the following figure:  



18 

 

 

The changes are important: for example, it is possible to block the viewport and select the scale from the list 

of standard scales (1:10, 1:100, etc.). The editable viewport is highlighted with a thick frame. To enter into the 

edit mode, double-click on the viewport and to switch to another viewport, click once.  

The references to the objects of viewports have been added. This allows you to prepare the inserted sections 

of drawing directly into the paper space: 
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Plot in the WiseMechanical 

Increased functionality of the drawings print was one of the main users’ wishes. The ability to print from 

preview, print the custom-sized layouts, more convenient printing using one settings dialogue. These and 

many other requests have been incorporated into the new version of WiseMechanical.   

Now you can set the necessary parameters in the Plot dialogue, such as choose a printer/plotter, paper size 

and orientation, plot scale, plot style, etc. 

Using the Plot dialogue, it is much easier and simpler to print the drawings: 
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When you set the plot area, the paper size and orientation is displayed (blue frame), print area border of 

printer/plotter (blue dotted frame), and the paper dimensions (yellow lines). 

Now it is easy to lay out drawings to print on smaller size papers: 
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Using the Print button located in the Plot Preview dialogue, you can print a customised worksheet 

immediately after viewing. 

The new Batch Plot command will be useful and convenient when you print large size documents or multiple 

documents. In the Publish dialogue you can set: State of plotting documents (1), number of copies (2), and 

then send a batch of documents to the printer (3): 

 

And some more new printing features:  
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- settings for custom paper; 

- opportunity to specify the model of multiple plot areas; 

- opportunity to save the plot settings as sets of parameters list.  

More features 

The finished work consists not only of the new and powerful features, but also of the optimisation of already 

familiar tools. Almost all of the tools were completed and optimised in the new version of WiseMechanical.  

New features 

 The new properties of Transparency can be set to any objects, such as hatch. 

 The new commands of Shape and FillShapes. 

 The hyperlinks insertion tool. 

 The new snap type: the intersection of extension vector. 

 The new Editing2 toolbar. 

 The ability to set the background colour and font of the command line. 

 The status bar now displays not only the absolute coordinates, but also the distance and angle. 

The program optimisation 

 Network licensing – more user-friendly work with licenses within an organisation. 

 Expanded memory support – WiseMechanical can use up to 3GB of RAM on 32-bit operating systems. 

 The on/off of the line weight or hatches showing no longer have to forced to set the image redrawing 

(REGEN command). It was possible after optimising the speed display on the screen – now even on multi-

megabyte drawings this operation doesn’t take much time.  

 Adjustments were made to the interface. Added the ability to create custom toolbars. 

 Spline can be cutting edge for objects in the Trim Vectors and Extend Vectors commands. 

 Work with splines was improved: now there are two methods of editing and graphical switch between 

these methods. 

 Dynamic blocks display more control buttons: rotate, scale, moving, choice of sizes, etc.  

 The Chamfer and Fillet commands work with zero values. 

 The plot is performed faster. 

 Displaying of a worksheet that contains many viewports is faster. 

 Interface is improved. It makes the program more convenient and enjoyable. 
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 The way some commands work was redone and the memory usage was reduced for some intermediate 

operations.  

 The Undo command was optimised: takes less RAM, undo commands was redone.  

 Dimensions: when creating a diametric dimension, arrows, which are not close to the dimensioned arc, 

are hidden. 

 

The stability and quality 

 A “breakdown” of graphics on small scales has been corrected. 

 The error of reset of properties when copying multiline text has been corrected. 

 Addition of Z-height, when copying the objects, has been corrected. 

 The “Zoom all” command has been corrected. Work with dense drawings has become more accurate. 

 Work using the User Coordinates System (UCS) has become more accurate. 

 Corrected snaps when working with large drawings (the entities have Z-heights). 

 The Extend command with arcs and text has been corrected. 

 The Copy Object Properties command (MATCHPROP) has been corrected. 

 In the Save dialogue the version list of different .dwg formats has been added.  

 Errors when working with tables were corrected. 

 

Other changes 

 A command to edit block insertions was added (Tools > Edit block insertion). 

 The Stretch command (Modify menu > Stretch): the preview of stretch points was added, logic of work was 

corrected. 

 The hatch (Draw > Hatch): the dialogue was corrected, search of contours, contour preview.  

o The Clipbook: Insertion of OLE objects in the drawing; 

o Because of copying data, it is possible to insert objects of BMP and Windows MetaFile format. 

 Settings (Tools > Settings parameters):  

o Adjustment of layers, profiles and colours can be made using the  button to open the 

corresponding dialogues; 
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o A setting Edit > Set associativity during insertion of objects was added 

o A setting Symbols>Notes>Rotate rack on UCS was added 

o A setting Notes> Show dialog before inserting the object was added. 

 Line width: 

o Showing line width in the paper space was corrected. This mistake could make work in the 

paper space difficult if the visibility of line width was switched on (SW button in the status 

bar); 

o Showing/hiding line width was corrected when the visibility of line widths is switched on/off  

(SW in the status bar); 

o The visibility of line widths was corrected in the printing preview ; 

o The printing of line widths was corrected using the tables of printing styles (ctb-, stb-files); 

o The saving of ctb, stb, pc3 and other utility files was corrected. 
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